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BAB III 

METODE PENELITIAN 

A. Tempat dan Waktu Penelitian 

Tempat pelaksanaan penelitian ini di MTs Baitul Ihza Sitapus 

Kecamatan Sangir Batang Hari Kabupaten Solok Selatan.Waktu penelitian ini 

adalah semester 1(ganjil), tahun pelajaran 2017/ 2018. 

B. Jenis dan Rancangan Penelitian 

Jenis penelitian ini adalah  penelitian eksperimen semu (quasi 

eksperimen).  Jenis penelitian eksperimen semu dipilih karena penelitian ini 

betujuan untuk menerapkan suatu tindakan berupa strategi dengan subjek 

manusia untuk meningkatkan efesiensi dan efektivitas suatu kegiatan agar 

hasilnya lebih optimal.Rancangan penelitian yang digunakan adalah 

Randomized Control Group Only Design, yaitu desain yang melibatkan dua 

kelompok subjek, satu diberi perlakuan eksperimental (kelompok 

eksperimen) dan yang satu lagi tidak diberi perlakuan eksperimen (kelompok 

kontrol). 

Penelitian eksperimen adalah untuk mengetahui ada tidaknya akibat 

dari sesuatu subjek yang diberi perlakuan, mencoba meneliti ada tidaknya 

hubungan sebab akibat dengan membandingkan satu atau lebih kelompok 

eksperimen yang diberi perlakuan dengan satu atau lebih kelompok 

pembanding yang tidak menerima perlakuan.
1
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Rancangan penelitian tersebut dapat dilihat pada Tabel berikut: 

Tabel 3.1 

Rancangan Penelitian 

Group Treatment Posttest 

Eksperimen X T 

Kontrol - T 

 

Keterangan: 

X: Perlakuan yang diberikan pada kelas eksperimen yaitu pembelajaran 

dengan metode Picture and Picture  

T:  Tes yang diberikan kepada kelas eksperimen dan kelas kontrol pada 

akhir pembelajaran.
2
 

C. Populasi dan Sampel 

1. Populasi 

Populasi adalah keseluruhan subjek penelitin.
3
Apabila seseorang 

ingin meneliti semua elemen yang ada dalam wilayah penelitian, maka 

penelitiannya merupakan penelitian populasi. Sesuai dengan judul 

penelitian maka yang menjadi  populasi dalam penelitian ini adalah  

seluruh peserta didik kelas VII MTs Baitul Ihza Sitapus yang terdaftar 

pada tahun  pelajaran 2017/2018. Distribusi jumlah peserta didik kelas VII 

MTs Baitul Ihza Sitapus dapat dilihat dalam Tabel berikut: 
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Tabel 3.2 

Jumlah Peserta Didik Kelas VII MTs Baitul Ihza Sitapus 

TahunPelajaran  2017/2018
4
 

No. Kelas Jumlah peserta didik 

1. VII.A 23 

2. VII.B 23 

Jumlah Keseluruhan 46 

 

2. Sampel 

Secara sederhana dapat dikatakan, bahwa sampel adalah sebagian 

dari populasi yang terpilih dan mewakili populasi tersebut. Sebagian dan 

mewakili dalam batasan di atas merupakan dua kata kunci dan merujuk 

kepada semua ciri populasi dalam jumlah yang terbatas pada masing-

masing karakteristiknya. Penggunaan sampel (bukan populasi) dalam 

penelitian bukan dimaksudkan untuk mengurangi ketelitian dan ketepatan 

hasil penyelidikkan ataupun prediksi terhadap suatu masalah yang akan 

diselidiki.
5
 

Dikarenakan populasi hanya dua kelas dan masing-masing kelas 

terdiri dari 23 orang peserta didik, maka peneliti mengambil seluruh 

peserta didik sebagai sampel, sehingga penelitian ini merupakan penelitian 

populasi.Pengambilan sampel untuk menentukan kelas eksperimen dan 

                                                           
4
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(Jakarta: Kencana, 2014), h. 150-151  
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kelas kontrol peneliti mengambil dua nomor secara acak (random 

sampling). Dan ditetapkan bahwa kelas yang terambil pertama adalah 

kelas eksperimen yaitu kelas VII A dan yang terambil kedua dijadikan 

sebagai kelas kontrol yaitu kelas VII B. Untuk kelas eksperimen pada 

penelitian ini adalah kelas yang sengaja diberikan perlakuan dengan 

metode Picture and Picture sedangkan kelas kontrol adalah kelas yang 

dalam proses pembelajaran menggunakan model pembelajaran 

Konvensional. 

D. Variabel dan Data 

1. Variabel 

Variabel merupakan pusat perhatian didalam penelitian kuantitatif. 

secara singkat, variabel dapat didefenisikan sebagai konsep yang memiliki 

variasi atau memiliki lebih dari satu nilai
6
. Dalam penelitian ini terdapat 

dua variabel yaitu: 

a. Variabel bebas 

Variabel bebas (independent variable) merupakan variabel 

yang mempengaruhi variabel lain atau menghasilkan akibat 

padavariabel yang lain, yang pada umumnya  berada dalam urutan tata 

waktu yang terjadi lebih dulu.Variable ini biasanya disimbolkan 

dengan variabel “x”.
7
 Pada penelitian ini variabel bebasnya adalah 

pembelajaran dengan menggunakan metode picture and picture. 

                                                           
6
Nanang Martono, Metode Penelitian Kuantitatif, (Jakarta: PT Raja Grafindo, 2014), h. 

59 
7
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b. Variabel terikat  

Variabel terikat (dependent variable) merupakan variabel yang 

diakibatkan atau dipengaruhi oleh variabel bebas.Variabel ini biasanya 

disimbolkan dengan variabel “y”.
8
 Pada penelitian ini variabel 

terikatnya adalah hasil belajar Fikih peserta didik.  

2. Data 

Data ialah bahan mentah yang perlu diolah sehingga menghasilkan 

informasi atau keterangan, baik kualitatif maupun kuantitatif yang 

menunjukkan fakta. Sedangkan perolehan data seyogyanya relevan, 

artinya data yang ada hubungannya langsung dengan masalah penelitian. 

Data yang sudah memenuhi syarat perlu diolah. Pengolahan data 

merupakan kegiatan terpenting dalam proses dan kegiatan penellitian.
9
 

Sumber data yang digunakan dalam penelitian ini adalah: 

a. Data primer 

Data primer adalah data yang diperoleh langsung dari 

sumbernya diamatidan dicatat untuk yang pertama kalinya. Data 

primer dari penelitian adalah post-test (tes yang dilaksanakan setelah 

diberikan treatment) pada peserta didik kelas eksperimen dan kelas 

kontrol. 

                                                           
8
Ibid.,h. 61 

9
Riduwan, Skala Pengukuran Variabel-Variabel Penelitian, (Bandung: Alfabeta, 2010), 

h. 5  
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b. Data sekunder 

Data sekunder adalah data yang bukan diusahakan sendiri 

pengumpulannya oleh peneliti. Data sekunder dari penelitan adalah 

nilai ulangan harian semester 1 kelas VII MTs Baitul Ihza Sitapus. 

E. Prosedur Penelitian  

1. Tahap Persiapan 

a. Menetapkan tempat dan jadwal penelitian. 

b. Mempersiapkan surat izin penelitian. 

c. Menentukan kelas sampel setelah dilakukan uji normalitas, uji 

homogenitas, dan uji kesamaan rata-rata.  

d. Mempersiapkan perangkat pembelajaran, seperti RPP, silabus dan bahan 

ajar. 

e. Validasi perangkat pembelajaran oleh dosen pembimbing dan guru Fikih 

MTs Baitul Ihza Sitapus.  

f. Menyusun instrumen penelitian, yaitu tes akhir.  

g. Validasi instrumen penelitian oleh dosen pembimbing dan guru Fikih 

MTs Baitul Ihza Sitapus.  

h. Menganalisis soal uji coba tes akhir, yaitu daya beda, tingkat kesukaran, 

dan reliabilitas soal tes akhir. 

i. Memperbaiki dan menyusun soal tes akhir. 

2. Tahap Pelaksanaan 
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Pelaksanaan penelitian ini dilakukan pada kedua kelas sampel. Pada 

kelompok eksperimen diterapkan metode picture and picture, sedangkan 

pada kelompok kontrol diterapkan pembelajaran konvensional. Tahapan 

pelaksanaan pada kelompok eksperimen adalah sebagai berikut: 

a. Kegiatan Awal  

1) Pendidik meminta peserta didik berdoa dan mempersiapkan diri untuk 

mengikuti pembelajaran.  

2) Mengadakan apersepsi dengan bertanya tentang materi yang telah 

dipelajari sebelumnya. 

3) Menyampaikan tujuan pembelajaran dan prosedur pembelajaran 

Picture and Picture. 

b. Kegiatan Inti  

Konstruktivisme 

1) Pendidik melakukan demonstrasi atau mengajak peserta didik pada 

situasi nyata terkait materi yang dipelajari. 

2) Pendidik mengajukan pertanyaan yang mengarahkan peserta didik 

mengkonstruksi pengetahuan barunya berdasarkan pengalamannya 

tersebut.  

Inkuiri 

3) Dengan pengetahuan yang diperoleh pesertta didik sebelumnya, 

peserta didik diajak untuk menemukan konsep atau materi yang 

dipelajari.  
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Inkuiri dilakukan dengan beberapa tahap yaitu merumuskan masalah, 

mengamati atau melakukan observasi, menganalisis dan menyajikan 

hasil dalam tulisan, gambar, laporan, bagan, table, dan karya lainya, 

mengkomunikasikan atau menyajikan hasil karya pada pembaca, 

teman sekelas, pendidik, atau audien yang lain. 

Bertanya  

4) Pendidik betanya tentang penemuan peserta didik, serta mengajak 

peserta didik untuk saling berinteraksi. (Proses bertanya juga 

berlangsung pada hampir setiap proses pembelajaran). 

Masyarakat Belajar 

5) Peserta didik dibagi ke dalam kelompok kecil yangheterogen  terdiri 

dari 3-4 orang.  

Pemodelan 

6) Pendidik meminta masing-masing kelompok untuk memperagakan 

atau menjelaskan hasil temuan mereka serta mendiskusikannya. 

Refleksi 

7) Peserta didik melakukan refleksi dengan menuliskan atau 

mengungkapkan kesan keberhasilannya sertakekurang pahamannya 

tentang konsep yang telah dipelajarinya. 

c. Kegiatan Akhir. 

Penilaian sebenarnya 

8) Pendidik mengadakan penilaian tes akhir.  

9) Pendidik mengadakan tindak lanjut.  
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3. Tahap Penyelesaian 

Tahap penyelesaian adalah memberikan tes akhir pada peserta didik 

kelas eksperimen dan kelas kontrol untuk mengetahui hasil perlakuan yang 

telah diberikan dan menganalisis data yang diperoleh. Sehingga dapat 

ditarik kesimpulan dari hasil yang diperoleh. 

F. Instrumen Penelitian 

Instrumen yang digunakan dalam penelitian ini adalah tes kemampuan 

pemahaman konsep fikih. Tes ini digunakan untuk mengukur kemampuan 

pemahaman konsep fikih peserta didik. Instrumen tes dibuat dengan langkah-

langkah sebagai berikut: 

1. Tes hasil belajar  

Tes hasil belajar berfungsi untuk mengukur tingkat kemampuan 

peserta didik. Materi tes yang akan diberikan berupa pilihan ganda atau tes 

objektif yang dilaksanakan di akhir penelitian dengan materi pelajaran yang 

diberikan selama penelitian  berlangsung. Untuk mendapatkan hasil tes yang 

baik, dilakukan beberapa langkah sebagai berikut : 

a. Menyusun kisi-kisi soal 

  Pembuatan kisi-kisi soal tes harus disesuaikan dengan materi 

pembelajaran Fikih, baik itu dari KI, KD, Indikator  dan Materinya. 

b. Menyusun tes berdasarkan kisi-kisi. 

  Setelah kisi-kisi soal selesai dibuat, maka selanjutnya adalah 

menyusun soal-soal tes hasil belajar. 

c. Melakukan uji coba tes 
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Sebelum tes diberikan kepada kelas sampel, tes diuji cobakan dulu 

kepada peserta didik kelas VII MTs Thawalip Padang yang masih 

memiliki karakteristik yang hampir sama dengan MTs Baitul Ihza 

Sitapus. Tujuan uji coba tes adalah untuk melakukan analisis butir soal 

agar didapat butir soal yang baik ditinjau dari validitas, homogenitas, 

tingkat kesukaran soal dan daya beda. adapun tujuannya yaitu: 

1) Memperbaiki pertanyaan-pertanyaan yang kurang jelas maksudnya. 

2) Memperbaiki pertanyaan-pertanyaan yang menimbulkan jawaban-

jawaban yang dangkal. 

3) Memperbaiki kata-kata yang terlalu asing, akademik, atau yang 

menimbulkan kecurigaan. 

4) Menambahkan item yang sangat perlu atau meniadakan item yang 

ternyata tidak relevan dengan tujuan penelitian. 

d. Analisis soal tes uji coba 

Setelah uji coba tes dilakukan dan telah didapatkannya hasil, 

maka selanjutnya dilakukan analisis item untuk melihat keberadaan 

soal-soal yang disusun apakah baik atau tidak. Dalam melakukan 

analisis item ada beberapa hal yang perlu diperhatikan, yaitu : 

1) Validitas tes 

 Validitas adalah suatu ukuran yang menunjukkan tingkat 

kevalidan atau kesahihan suatu tes. Suatu tes yang sahih akan 

mempunyai validitas yang tinggi, sebaliknya tes yang kurang sahih 

berarti memiliki validitas yang rendah. Tes dikatakan valid apabila 
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tes tersebut dapat mengukur apa yang hendak diukur. Validitas yang 

dilihat adalah validitas item. 

 Validitas tes pelu ditentukan untuk mengetahui kualitas tes 

dalam kaitannya dengan mengukur hal yang seharusnya diukur. Ada 

empat jenis validias, yaitu validitas isi (contens validity), validitas 

konstruk (construct validity), validitas prediktif (predictive validity), 

dan validitas konkuren (concurent validity). Dalam penyusunan 

instrumen, peniliti berpedoman pada validitas isi. Apabila tes yang 

disusun sudah berdasarkan kisi-kisi yang telah dibuat, maka tes telah 

memenuhi validitas isi.  

2) Reliabilitas suatu tes merupakan tingkat kepercayaan dari tes 

tersebut. Untuk menentukan reliabilitas tes dipakai rumus Kuder dan 

Richardson: 

r11 = 








1n

n







 


)(n)(St

Mt)Mt(n
1

2
 

Keterangan:

 r11 = Reliabilitas tes secara keseluruhan

 
n = Jumlah item soal

 
1 = Bilangan konstan 

Mt = Mean total ( Rata-rata hitung dari skor total ) 

 
St

2 
= Varian total 

 

Kriteria: 

0,90  <  r11  1,00 =    Reliabilitas sangat tinggi 
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0,70  <  r11   0,90 =    Reliabilitas tinggi 

0,40  <  r11  0,70 =    Reliabilitas sedang 

0,20  <  r11  0,40 =    Reliabilitas rendah 

0,00  <  r11  0,20 =    Reliabilitas sangat rendah 

3) Indeks kesukaran soal digunakan untuk melihat apakah soal 

tersebut termasuk soal yang mudah, sedang, atau sukar. Angka 

indeks kesukaran soal dapat diperoleh dengan menggunakan 

rumus. 

P =
Js

B
 

Keterangan : 

P =  Angka indeks kesukaran soal 

  B = Banyaknya siswa yang dapat menjawab soal dengan betul 

Js =  Jumlah siswa yang mengikuti tes hasil belajar. 

 

Kriteria : 

Kurang dari 0,25 =  Terlalu sukar 

0,25 – 0,75  =  soal cukup (sedang) 

Lebih dari 0,75 =  Terlalu mudah  

 

4) Daya Pembeda Soal 

Daya pembeda soal adalah kemampuan sesuatu soal untuk 

membedakan anatar siswa yang pandai (berkemampuan tinggi) 

dengan siswa yang bodoh (berkemampuan rendah). 

D = PA  -  PB 

     
  

  
   dan     

  

  
 

Keterangan : 

 D =  Discriminatory power (angka indeks kesukaran item) 
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 PA   = Proporsi peserta kelompok atas yang dapat menjawab   

dengan  betul    butir item yang bersangkutan 

 PB     = Proporsi peserta kelompok bawah yang dapat menjawab  

dengan betul butir item yang bersangkutan  

BA = Banyaknya peserta kelompok atas yang dapat menjawab 

dengan betul butir item yang bersangkutan 

BB =  Banyaknya peserta kelompok bawah yang dapat 

menjawab dengan betul butir item yang bersangkutan 

J =   Jumlah peserta tes 

JA = Jumlah pesertayang termasuk dalam kelompok atas 

JB =   Jumlah peserta yang termasuk dalam kelompok bawah 

 

Kriteria : 

Kurang dari 0,20  =  Jelek 

0,20 – 0,40  =  Cukup (sedang) 

0,40 – 0,70  = Baik 

0,70 – 1,00  =  Baik Sekali 

Bertanda Negatif  = Jelek sekali 

 

Kriteria daya pembeda soal yang dipakai dalam penelitian ini 

berkisar antara 0,20 sampai dengan 1,00. 

G. Teknik dan Alat Pengumpulan Data 

Sesuai dengan jenis penelitiannya maka teknik pengumpulan data 

yang peneliti gunakan adalah teknik pengukuran.
10

 Dengan kata lain  adalah 

tes dengan intrumen pengumpulan datanya adalah tes hasil belajar. Tes adalah 

serentetan pertanyaan atau latihan serta alat lain yang digunakan untuk 

mengukur keterampilan, pengetahuan, intelegensi kemampuan atau bakat 

yang dimiliki individu atau kelompok.
11

Sedangkan tes prestasi 

(achievementtest) adalah tes yang digunakan untuk mengukur pencapaian 
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Anas Sudijono, Pengantar Evaluasi Pendidikan, (Jakarta: PT. Raja Grafindo Persada, 

2005), h. 254 
11

Ibid., h. 150 
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seseorang setelah mempelajari sesuatu.
12

 Yang dimaksud disini adalah 

pemberian serangkaian butir-butir soal kepada responden untuk diselesaikan 

atau dijawab, setelah dilakukan eksperimen. 

H. Teknik Analisis Data 

Analisis data hasil penelitian ini menggunakan metode statistik untuk 

melihat keberhasilan siswa dalam belajar, yang menentukan pengolahan 

datanya dilakukan dengan uji normalitas dan uji homogenitas. 

1. Uji Normalitas 

  Uji  normalitas  data  dilakukan  untuk  mengetahui apakah data 

yang diperoleh didistribusikan normal atau tidak. Pengujian  normalitas  

data menggunakan  SPSS versi 22. Dengan kriteria pengujian  terima Ho 

apabila  ttabel <  thitung < ttabel , ttabel = t1 - 
 

 
  distribusi t dengan derajat  

kebebasan  dk =  n1 +   n2-  2,  taraf  signifikan 5%  dan tolak H0  untuk 

harga t  lainnya. Pengujian  normalitas  data  dengan menggunakan 

program SPSS versi 22 dengan langkah-langkah : Memasukan data hasil 

belajar kelas eksperimen dan kelas kontrol > Klik Analyze > Descriptive 

Statistics > Explore > Dependent List > Plots > Klik Faktor Levels 

Together > Klik Histogram > Klik Normality Plots With Test > Klik 

Continue.
13

  

2. Uji Homogenitas 

                                                           
12

 Riduwan, Belajar mudah Penelitian Untuk Guru, Karyawan, dan Peneliti pemula, 

(Bandung: Alfabeta, 2005), Cet.I, h.77 
13

 Getut Pramesti, Smart Olah Data Penelitian dengan SPSS 21, (Jakarta: Elex Media 

Komputindo, 2013), h. 15 
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Uji ini digunakan untuk mengetahui apakah kelompok eksperimen  

dan kelompok kontrol yang  ditetapkan  berasal dari populasi yang 

memiliki varian yang relatif sama. Rumus yang digunakan untuk 

mengujinya menurut Sudjana atau bisa juga menggunakan program SPSS 

versi 22 . Rumus yang digunakan Sudjana adalah: 

2

2

2

1S

S
F   

Keterangan: 

S1
2 

= variansi hasil belajar kelas eksperimen 

S2
2 

= variansi hasil belajar kelas kontrol 

 

Hipotesis yang diajukan: 

:0H  sampel mempunyai varians yang sama  

Ha :  sampel mempunyai varians yang tidak sama 

Kriteria pengujian: 

Apabila Fhitung< Ftabel  maka  data  berdistribusi homogen Ha 

ditolak. H0 diterima berarti varians homogen.
14

 Pengujian homogenitas 

data menggunakan program SPSS versi 22 dengan langkah-langkah 

berikut: Memasukan data hasil belajar kelas eksperimen dan kelas 

kontrol >  Klik Analyze > Klik Compare Means > Klik One Way 

ANOVA > Dependent List > Klik Options > Klik Descriptive > Klik 

Homogenety of variance test > Klik Means Plot > Klik Continue.  

3. Pengujian Hipotesis 

                                                           
14

 Sudjana, Metode Statistika, (Bandung: Tarsito, 2005), h. 250 
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 Setelah  sampel diberi perlakuan yang berbeda, maka dilaksanakan 

tes akhir. Teknik statistik yang digunakan adalah teknik  t-test  untuk 

menguji  signifikansi  perbedaan  dua  buah mean  yang  berasal  dari  dua  

buah  distribusi.  Pada  penelitian ini,  data  yang  digunakan  pada  

perhitungan  ini  adalah  data posttest.  Dari  hasil  tes  akhir  ini  akan  

diperoleh  data  yang digunakan  sebagai  dasar  dalam menguji  hipotesis  

penelitian, yaitu hipotesis diterima atau ditolak. Pengujian hipotesis yang 

digunakan adalah sebagai berikut :  

Ha: Terdapat perbedaan hasil belajar antara peserta didik yang  

menggunakan   metode pembelajaran Picture and Picture dengan 

peserta didik  yang menggunakan pembelajaran konvensional pada 

pembelajaran Fikih di kelas VII.A MTs Baitul Ihza Sitapus. 

Ho: Tidak Terdapat perbedaan hasil belajar antara peserta didik yang 

menggunakan metode pembelajaran Picture and Picture dengan 

peserta didik  yang menggunakan pembelajaran konvensional pada 

pembelajaran Fikih di kelas VII.A MTs Baitul Ihza Sitapus. 
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Untuk menguji hipotesis digunakan uji kesamaan dua rata-rata. Hasil uji 

normalitas dan uji homogenitas, data terdistribusi normal dan dua 

kelompok data mempunyai varians yang homogen, maka digunakan uji t 

dengan rumus : 

 t =        dengan         s
2
 =  

Ket: = Skor rata-rata nilai kelas eksperimen 

= Skor rata-rata kelas kontrol 

    s
2 

= Variansi dari kedua sampel 

  n1 = Jumlah peserta didik kelas eksperimen 

    n2 = Jumlah peserta didik kelas kontrol. 

Kriteria hipotesis diterima jika thitung > t  dilihat pada daftar  

distribusi t dengan derajat kebebasan df = n1 + n2 - 2 dan peluang . 

Hipotesis ditolak jika thitung ≤ t  dilihat pada daftar distribusi t dengan 

derajat kebebasan df = n1 + n2 - 2 pada taraf signifikan 0,05.  
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